
MOR2 DATA ANALYSIS & 

SCIENTIFIC WRITING WORKSHOP 

November 18-21, 2014, Ulaanbaatar, Mongolia 



Agenda 

 Welcome, Introductions, Objectives 

 Day 1: Research questions, literature review, 

hypotheses, statistical assumptions, data transformation 

 Day 2: Data analysis, creating graphs and tables 

 Day 3: Organizing and writing a scientific paper 

 Day 4: Peer review process, complete conference 

abstracts, workshop evaluation 

 

 

 



Day 1 & 2 Objectives 

Participants should be able to: 

1. Describe the  process of the scientific method 

2. Write a testable hypothesis 

3. Identify dependent and independent variables 

4. Identify different data types: nominal, ordinal & scale 
variables 

5. Distinguish inferential from descriptive statistics 

6. Learn to test hypotheses using SPSS 

 Regression (continuous x continuous) 

 ANOVA (categorical x continuous) 

 Cross-tabulations (categorical x categorical) 

 

 

 

 

 



1. Hypothesis Development 



Scientific method 

Literature Review 

Conceptual Model 

Peer Review 



Key terms 

 Hypothesis: 

An educated guess about how things work.  

A statement about cause and effect.   

Example: If we put fertilizer on a field, the 

yield will increase. 

 Theory: 

A confirmed hypothesis. 

 

 



A good hypothesis 

 Is testable and falsifiable 

 Sets the research direction 

 Identifies the important variables 

Independent (explanatory) 

Dependent (outcome) 

 Is grounded in theory 

 Is short and clear 



Hypothesis 

 Goal is to test a hypothesis in a way that it can be 

shown to be false. 

 The goal IS NOT to “prove” the hypothesis. 



Independent & Dependent 

Variables 

 The factors you will measure to test your 

hypothesis 

 A dependent variable is the outcome or 

response variable that is affected in the 

experiment or study.   

 An independent variable is the explanatory 

variable that causes the effect.  In an 

experiment, it is the variable that you change.   



Example 

Hypothesis:  Total plant cover increases 

with increasing distance from a winter 

camp. 

Distance from camp is the independent 

variable 

 Total plant cover is the dependent 

variable 

 



Which is independent variable? 

Which is the dependent variable? 

 Hypothesis 1: Shrubs prefer sandy soils to soils 

with high clay content. 

 Hypothesis 2: The cover of annual forbs increases 

closer to winter camps. 

 Hypothesis 3: Households that are CBRM 

members are more likely to reserve winter 

pastures than non-CBRM households. 

 



Testable and Falsifiable 

 You can disprove or reject the hypothesis by 

performing an experiment, or collecting data in an 

observational study. 

 Example:   

 Hypothesis: Adding fertilizer will increase hay yield. 

 We have a uniform hay field divided into treatment 

plots, and add fertilizer to 10 randomly selected plots, 

leaving 10 plots untreated. 

 If yield does not increase in the treated plots, our 

hypothesis is rejected. 

 



Some Broad Hypotheses from MOR2 

Project 

 Winter pastures grazed by CBRM members are more 

productive, diverse, and healthy than those grazed by 

non-members. 

 Households that belong to CBRM groups are more 

innovative and have higher social capital. 

 



You do it! Create a hypothesis 

 Based on your research question and knowledge of MOR2 

data: 

 Write a testable hypothesis 

 Identify the dependent variable(s) 

 Identify the independent variable(s) 

 What existing theory or knowledge is this hypothesis based 

on? (Explain WHY you think this hypothesis is true) 

 Discuss your draft hypothesis with another person  

 Give the other person feedback on their hypothesis 

 Report back to the group 



2. Data Preparation 

Data Types, Descriptive Statistics, Exploratory 

Analysis & Data Transformations 



Types of Data 

 Scale (continuous) variables have values that vary continuously, such 

as the percent cover of a plant species, or income in MNT. 

 Nominal (categorical) variables are discrete categories, such as “Yes” 

and “No” responses on a survey, or categories of soil texture “Sandy 

Loam,” “Clay Loam,” etc. 

 Ordinal variables are discontinuous variables that occur in a 

meaningful  numerical order, for example, the responses to a survey 

question “1=strongly disagree, 2=somewhat disagree, 3=neutral, 

4=somewhat agree, 5=strongly agree” 



Open data in SPSS 

 Find your dependent and independent variables 

 Identify what variable types they are 

 Scale 

 Nominal 

 Ordinal 

 Record the variable types on your worksheet tables 



Create a New Data Set 

 Data > Select Cases > If condition met 

 

 To select data only for Selenge Bayangol & 

Saikhan, Tuv Bayan & Bayantsagaan, and Dundgovi 

Ulziit & Undurshil 

 Look up the soum codes for each soum 

 In “If condition met” enter: 

 SoumCode = 2503 OR SoumCode = 2510 OR SoumCode 

= 2705 OR SoumCode = 2710 OR SoumCode = 1814 OR 

SoumCode = 1815  

 Save output as new file 



Descriptive Statistics 

Descriptive statistics describe the 

characteristics of the sample units 

in terms of the central tendency 

(average) and variation (standard 

deviation). 
 



Descriptive Statistics 

Mean (average) X= Sum of 

observations/number of observations 

Median = the middle observation 

Variance (s2)= ∑(Xi-X)2/n-1 

 Standard Deviation (s)= √s2 

 Standard Error (SE) = 2/√n 

Coefficient  of Variation (CV) = (s/X)*100 



Descriptive Statistics in SPSS 

Analyze 

Descriptives 

Explore 

Identifies outliers 

Tests for normality 

 



Data Exploration in SPSS 

Scatter 

Plots 



Data Exploration in SPSS 

Bar Graphs 



Data Exploration in SPSS 



Testing Statistical Assumptions 

 Data come from a normal distribution 

 Plot a histogram 

 Normal probability plot 

 



Transforming Data in SPSS 

  Transform 

 Compute Variable 

 Target Variable Name [Type LNGrassBiomass] 

 Numeric Expression [Type: LN (Grass_gm2 + 1) 

 Click OK 

 A new column of data will appear at the end of your 

dataset, labelled “LNGrassBiomass” 



Transforming Data in SPSS 

 Inferential statistics assume that  

 the data come from a normal distribution, and  

 the variances from the groups being compared are 

roughly equal.  

 If the data do not meet these assumptions, they need 

to be transformed.  

 Also, if there are a large number of low or zero 

values, it is helpful to transform the data. 

 Useful transformation for cover and biomass data is: 

 Ln (Biomass +1) 



Transforming Data in SPSS 

 Transformed grass biomass data: 

 

Log transformed grass biomass data are normally distributed. 



Testing Statistical Assumptions 

 Variances are homogeneous 

 Look at a scatter plot 

 In SPSS: Analyze > General Linear Model > Univariate 

> Options > Homogeneity tests 

No difference in variances 

at different distances from 

Impact point. 



You do it! 

 Identify scale variables that you want to analyze 

 Calculate descriptive statistics for them 

 Explore them graphically 

 Determine if they meet assumptions of normality 

and equal variances 

 Transform them if they do not meet the assumption 

(create a new variable) 

 Record the results of your assessments and 

transformations in the tables of your worksheet 



3. Hypothesis Testing with Inferential Statistics 



Inferential Statistics 

 Inferential statistics use data from the 

sample to draw conclusions about the 

population from which the sample was 

drawn.  To determine if two samples 

come from different populations, we 

need to use inferential statistics.  To test 

our hypotheses, we must use inferential 

statistics. 

 



What are inferential statistics for? 

Are the populations different? 

How confident are we that they 

differ? 



Hypothesis Testing 

 To determine whether data from two samples are 

different, we must use inferential statistics. 

 Example: To compare the difference between the 

distance moved by poor herders and wealthy 

herders. 

 We CANNOT draw conclusions about differences or 

test our hypotheses with descriptive statistics. 



% Native Grass Cover 

A. Heavy 

Grazing 

B. Moderate 

Grazing 

C. No 

Grazing 

Plot 1 15 50 10 

Plot 2 21 37 19 

Plot 3 5 63 7 

Plot 4 13 41 38 

Plot 5 8 47 51 

Mean 12.4 47.6 25 

Variance 38.8 99.8 357.5 



Statistical Null Hypothesis 

Mean cover for A = B = C 



How do inferential statistics work? 

 
It’s all about the variance 

Ratio of the variation between 

groups vs. within groups 

As this ratio becomes larger, the 

likelihood of a real difference 

increases 



How do inferential statistics work? 

It’s all about the variance 

t = (difference between sample means)/ 

[2 x (average variance of the samples)/(sample 

size)] 

  

 

F = between-groups variance/ 

  within-groups variance 



How to interpret P-values 

When the test statistic (t, F) is large, then the 

probability of obtaining this result by chance is 

small.  

By convention, when P < .05 we reject the null 

hypothesis that the means are the same.  

We conclude that the means come from populations 

that are significantly different.  

 



t-Test: Two-Sample Assuming Equal Variances 

Site A and Site B 

  Site A Site B 

Mean 12.4 47.6 

Variance 38.8 99.8 

Observations 5 5 

Pooled Variance 69.3 

Hypothesized Mean Difference 0 

df 8 

t Stat 6.685687152 

P(T<=t) one-tail 7.7489E-05 

t Critical one-tail 1.85954832 

P(T<=t) two-tail 0.000154978 

t Critical two-tail 2.306005626   



t-Test: Two-Sample Assuming Equal Variances 

Site A and Site B 

  Site A Site B 

Mean 12.4 47.6 

Variance 38.8 99.8 

Observations 5 5 

Pooled Variance 69.3 

Hypothesized Mean Difference 0 

df 8 

t Stat 6.685687152 

P(T<=t) one-tail 7.7489E-05 

t Critical one-tail 1.85954832 

P(T<=t) two-tail 0.000154978 

t Critical two-tail 2.306005626   

Calculated t-value 

Critical value for t 

P-value 



So, we can … 

 We reject the null hypothesis that A = B 

 Conclude that cover of native grasses on site B 

(moderately grazed) is significantly greater than on 

site A (heavily grazed). 



t-Test: Two-Sample Assuming 

Unequal Variances 

Site B and Site C 

  Site B Site C 

Mean 47.6 25 

Variance 99.8 357.5 

Observations 5 5 

Hypothesized Mean Difference 0 

df 6 

t Stat 2.363158442 

P(T<=t) one-tail 0.028020894 

t Critical one-tail 1.943180905 

P(T<=t) two-tail 0.056041789 

t Critical two-tail 2.446913641   



t-Test: Two-Sample Assuming 

Unequal Variances 

Site A and Site C 

  Site A Site C 

Mean 12.4 25 

Variance 38.8 357.5 

Observations 5 5 

Hypothesized Mean 

Difference 0 

df 5 

t Stat -1.41528372 

P(T<=t) one-tail 0.108070664 

t Critical one-tail 2.015049176 

P(T<=t) two-tail 0.216141329 

t Critical two-tail 2.570577635   



Overall Conclusions 

 Moderately grazed (B) > Heavily grazed (A) 

 Moderately grazed (B) = No grazing (C)* 

 Heavily grazed (A) = No grazing (C) 

 

*If you use Type I error rate of 5% 



Types of Error 

NO 

DIFFERENCE 

REAL 

DIFFERENCE 

DIFFERENCE 

DETECTED 

False-change 

error (Type I) 

α 

No error 

(Power) 

1-β 

NO 

DIFFERENCE 

DETECTED 

No Error Missed-change 

error (Type II) 

β 



P-value 

 The P-value or significance value of a given 

statistical test is the probability of making a false-

change (or Type I) error. Given the null hypothesis is 

true (there is no difference), it is the probability that 

the test determined there was a significant 

difference between means. 

 We generally want to minimize this chance of a 

Type I error, and by convention, most scientists use a 

cut-off of 5% (p=<0.05) as the acceptable false-

change error rate.    



Types of Analysis 

Type of Data Type of 

Analysis 

Example 

2 scale (continuous) 

variables 

Linear regression Grass biomass x % Clay in 

soil 

1 nominal x 1 scale 

(continuous) 

T-test (if 2 groups) 

ANOVA (more than 2 

groups) 

CBREM membership x % 

foliar cover 

Distance from impact x 

species richness 

2 nominal 

(or ordinal) 

Chi-square 

Cross-tabulation 

CBRM member x Fall Otor 



Example: Linear Regression 

 Ecological Hypothesis: Grass Biomass increases with 

increased soil clay content because clay soils hold 

water close to the soil surface 

 Dependent variable = LN Grass Biomass 

 Independent variable = % Clay in Horizon 1 

 Analyze 

 Regression 

 Linear 

 Statistics > Model fit, R square change, Estimates  

 Statistical null hypothesis: No relationship, line flat 

 



Example: Linear Regression 

LN Grass Biomass x %Clay in Horizon 1 

Can we reject the null 

hypothesis? 

 

If so, is the relationship the 

one that we hypothesized? 



Example: Linear Regression 

LN Grass Biomass x %Clay in Horizon 1 

Can we reject the null 

hypothesis? Yes! 

 



Example: Linear Regression 

If so, is the relationship the one that we hypothesized? 



Example: ANOVA 

 Ecological Hypothesis: Grass Biomass increases with 

increased increasing distance from uvuljaa 

 Dependent variable = LN Grass Biomass 

 Independent variable = Distance from Impact  

 Analyze 

 General Linear Model 

 Univariate 

 Dependent variable = LNGrassBiomass 

 Random factor = Distance from Impact 

 Statistical null hypothesis: mean 100-m = mean 

500-m = mean 1000-m 



Example: ANOVA 

Do we accept or reject our null hypothesis that the means are the same? 



Example: ANOVA 

There is an apparent trend in 

the data, but no statistically 

significant difference among 

the means. 

We accept the statistical null 

hypothesis that the means 

are the same. 

 

We reject our ecological 

hypothesis that grass 

biomass increases with 

distance from impact. 

If the SE bars overlap, there is no statistical difference 



Example: Chi-square 

 Use Household Survey Data Set 

 Research Hypothesis: CBRM member households will 

do more to prepare for winter than non-CBRM 

households 

 Statistical Hypothesis: frequencies of winter 

preparation actions do not differ between CBRM and 

non-CBRM households 

 



Example: Chi-square 

 Dependent variable(s): Reserve Winter Pasture, Cut 

Hay, Deworm Livestock 

 Independent variable: CBRM organization member 

 Analyze 

 Cross-tabs 

 Row = CBRM Org 

 Column = Reserve Winter Pasture 

 Statistics: Chi-square 

 Cells: row, column and total percent 

 



Example: Chi-square 

Accept or reject our 

statistical hypothesis? 



Questions? 



You do it! Select Your Test  

 Review and revise your scientific hypothesis based on 

the feedback you received 

 Write a statistical “null hypothesis” to test your scientific 

hypothesis 

 Identify whether the variables are continuous (scale), 

nominal, or ordinal 

 Determine which analysis to use to test your hypothesis 

 Discuss your choice with another person and review their 

choice 



You do it! Test and Interpret   

 Use SPSS to test your statistical hypothesis 

 Based on the results, decide whether to accept or reject 

the statistical null hypothesis 

 Do the results support or reject your scientific 

hypothesis? 

 How do you explain your results? (What do you think 

you results mean?) 


